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Para desarrollar aplicaciones Android debemos instalar el siguiente software en
nuestro ordenador:

e JAVA
e ECLIPSE
e ANDROID SDK

Y configurarlo adecuadamente.

Vamos a dividir el proceso de instalacion y configuracion de estas herramientas en 4

pPasos:
1. INSTALACION DE JAVA SE IDK
2. INSTALACION DE ECLIPSE + ANDROID SDK con el “SDK ADT BUNDLE”
3. CREACION DE MAQUINAS VIRTUALES ANDROID
4. EJEMPLO HOLA MUNDO
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PASO 1: INSTALACION DE JAVA SE JDK

El primer paso es instalar Java SE JDK que puede descargarse de
http://www.oracle.com desde el apartado de downloads.
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Figura 1. http://www.oracle.com Java for Developers.

Exactamente, el enlace es:

http://www.oracle.com/technetwork/java/javase/downloads/jdk7-downloads-1880260.html

Y nos descargamos el paquete de instalacion seguln el sistema operativo que tengamos
instalado en nuestro ordenador. Para el caso de Windows, disponemos de la versién
de 64 bits (Windows x64) y de 32 bits (Windows x86). En el caso que utilicemos Win7
debemos comprobar si es de 32 o 64 bits. Para Windows XP, nos descargaremos el
paquete Windows x86.


http://www.oracle.com/index.html
http://www.oracle.com/index.html
http://www.oracle.com/technetwork/java/javase/downloads/jdk7-downloads-1880260.html
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Figura 2. Paquetes de instalacién de Java SE Development kit 7ul7, clasificados

Windows x86

Windows x64

por sistemas operativos

88.75 MB # jdk-7ul7-windows-i586.exe

90.42 MB # jdk-7ul7-windows-x64.exe

Figura 3. Java SE Downloads para Windows

También podemos descargar estos paquetes localmente de la pagina de material del

curso: http://Icsi.umh.es/androidmaterial

La instalacion es muy sencilla, simplemente ejecutar el paquete de instalacién vy

aceptar todos los pasos.
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PASO 2:

INSTALACION DE ECLIPSE + ANDROID SDK con el “SDK ADT
BUNDLE"

El siguiente paso es la instalacion del SDK de Android junto con el entorno de
desarrollo multiplataforma (/DE) Eclipse.

En la actualidad, existe un paquete de descarga denominado “SDK ADT bundle” que
combina el SDK de Android con la plataforma de desarrollo Eclipse y el plugin ADT
(que permite el uso del SDK de Android desde eclipse).

Debemos descargar este paquete de instalacion para Windows (o cualquier otro
sistema operativo), desde el enlace:

http://developer.android.com/sdk/index.html

Se recomienda desactivar el antivirus del equipo para que no interfiera en el proceso
de instalacion.

La figura 4 muestra la web de descarga del SDK ADT bundle. Se debe pinchar en el
botén azul de “Download” y aceptar los términos y condiciones (ver figura 5).
También debemos seleccionar la opcién de 32 o 64 bits, segun la configuracién de
nuestro sistema.

La figura 6 muestra los requerimientos necesarios del sistema para la correcta
instalacién del bundle.

En caso de tener un sistema operativo diferente a Windows, id a la seccién de
“DOWNLOAD FOR OTHER PLATFORMS” y buscad el paquete correspondiente a
vuestro sistema operativo Linux o Mac, (ver la figura 7).


http://developer.android.com/sdk/index.html
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Developer Tools Get the Android SDK
Download =
The Android SDK provides you the AP libraries and

Setting Up the ADT developer tools necessary to build, test, and debug

B apps for Android.
Setting Up an ~ | .
Existing IDE If you're a new Android developer, we recommend you

download the ADT Bundle to quickly start developing
apps. It includes the essential Android SDK
components and a version of the Eclipse IDE with
built-in ADT (Android Developer Tools) to streamline

Exploring the SDK
Download the NDK

Workflow v your Android app development.
Tools Help ~ With a single download, the ADT Bundle includes
everything you need to begin developing apps:
Revisions ~ . .
+ Eclipse+ ADT plugin
Extras v + Android SDK Tools
+ Android Platform-tools
Samples .
+ The latest Android platform
ADK ~ + The latest Android system image for the emulator

installing the Android SDK. See the following instructions.
~ USE AN EXISTING IDE

~ SYSTEM REQUIREMENTS

~ DOWNLOAD FOR OTHER PLATFORMS

[ v s A 0 g L. B T
/& Android SDK | Andraid De. {1 — — - —
€& = C [ developer.android.com/sdk/index.htm 9 o® A
lﬁl Developers - Design Develop Distribute Q H
Training API Guides Reference Tools Google Services

If you prefer to use an existing version of Eclipse or another IDE, you can instead take a more customized approach to
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Figura 4. Pagina de descarga del SDK ADT BUNDLE de Android
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Before installing the Android SDK, you must agree to the following terms and conditions.
Setting Up the ADT

[ o =g
/i Android SDK | Android De. =\ | o -

- C' | [ developer.android.com/sdk/index.html#download e @
lﬁ' Developers ~ Design Develop Distribute Q
Training APl Guides Reference Tools Google Services

Developer Tools Get the Android SDK
Download =

Bundle
L _
Setting Up an w -
! Existing IDE Terms and Conditions
Exploring the SDK . . A
(| ¥ . This is the Android Software Development Kit License Agreement
b Download the NDK
\ 1. Introduction
Workflow v
1.1 The Android Software Development Kit (referred to in this License Agreement as the "SDK" and specifically
| Tools Help - including the Android system files, packaged APIs, and Google APIs add-ons) is licensed to you subject to the terms
i - of this License Agreement. This License Agreement forms a legally binding contract between you and Google in
Hevisitis v relation to your use of the SDIK.
| Extras v - : - : _
1.2 "Android” means the Android software stack for devices, as made available under the Android Open Source
(| Samples Project, which is located at the following URL: http://source android.com/, as updated from time to time.
il ADK " 1.3"Google" means Google Inc., a Delaware corporation with principal place of business at 1600 Amphitheatre
Parkway, Mountain View, CA 94043, United States.
|l

»

m |

| have read and agree with the above terms and conditions

@ 32-bit © 64-bit

Download the SDK ADT Bundle for Windows

Excep under Greative Gommens Attribution 2.5, F e Content License

About Android | Legal | Support
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Figura 5. Aceptar términos y condiciones y seleccionar la opcion 32 o 64 bit para que
comience la descarga del bundle.
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- T — ="
/i Android SDK | Andraid D <\ L P — - - i
€ = C [ developer.android.com/sdk/indexhtml#download 9 o® A
N ~ USE AN EXISTING IDE i
Devcloperigols ~ SYSTEM REQUIREMENTS
Download - Operating Systems Eclipse IDE
Setting Up the ADT * Windows XP (32-bit), Vista (32- or 64-bit), or * Eclipse 3.6.2 (Helios) or greater
Bundle Windows 7 (32- or 64-bit) Note: Eclipse 3.5 (Galileo) is no longer supported
Setting Up an " + MacOS X 10.5.8 or later (x86 only) with the latest version of ADT. |
Existing IDE * Linux (tested on Ubuntu Linux, Lucid Lynx) * Eclipse JDT plugin (included in most Eclipse IDE
Exploring the SDK © GNUC Library (glibc) 2.7 or later is required. packages)
Download the NDK o OnUbuntu Linux, version 8.04 or later is ¢ JDKS (JRE aloneis not sufficient)
required. ® Android Development Tools plugin (recommended)
Workflow v o 64-bit distributions must be capable of running * Not compatible with GNU Compiler for Java (gcj)
32-bit applications.
Tools Help v Other development environments
o * JDK b (JRE alone is not sufficient)
R ~
evisions * Apache Ant 1.8 or later
Extras ~ * Not compatible with Gnu Compiler for Java (gcj)
samples Note: Some Linux distributions may include JDK 1.4
or Gnu Compiler for Java, both of which are not L
ADK v supported for Android development. 1

~ DOWNLOAD FOR OTHER PLATFORMS

Except as noted, this content is licensed under Creative Commons Attribution 2.5. For details and restrictions, see the Content License.
About Android | Legal | Support

g\adt—bundle—wmdows....zwp .
86,3 de 399 MB, & minut...

¥ Mostrar todas las descargas... %

&

Figura 6. Requerimientos del sistema
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installing the Android SDK. See the following instructions.
Developer Tools
| ~ USE AN EXISTING IDE
Download =
~ SYSTEM REQUIREMENTS
Setting Up the ADT
T ~ DOWNLOAD FOR OTHER PLATFORMS
Setting Up an " ADT Bundle
Existing IDE 2
Exploring the SDK . B ) :
ploring the Windows 32-bit | adtbundle-windows x86.zip 418030042 Ce32861d8TcO3f61f6071bdoad228e
Download the NDK bytes
Windows b4-bit adt-bundle-windows- 418155677 f09aa4557bd1dc2703fded5dcddebaze
Workflow v .
! Xx86_64.zip bytes
Tools Help > Mac0S X 64-bit = adt-bundle-mac-x36_64.zip 383216991 eabc074ee30c426¢503dab5c225a5076
i bytes
Revisions ~ . . . 8
! Linux 32-bit adt-bundle-linux-x86.zip 411205048 e64594cd339b8d9a400b9d16c616b3c3
Extras v bytes
‘ Linux 64-bit adt-bundle-linux-x86_64 zip 411478695 582bfco083ffacbefaccg223bdac3bel
Samples by
ytes
' DI " SDKTools Only
Windows = android-sdk_r21.0.1-windows.zip 90107847 613568d774c3bf25c5d24db16601af83
bytes
installer_r21.0.1-windows.exe 76520869 e2012262471a2583d4a559b1 5fcf45ff J
(Recommended) bytes
Mac0S android-sdk r21.0.1-macosx.zip 65804128 30401c43a014cd5d6ecod0c62854a1d9
X bytes
Linux android-sdk_r21.0.1-linux.taz 91304975 eaa5a8d76d692d1d027f2bbceed19644 S
adt-bundle-windows...zip
B 114 de 399 ME, 5 minuto...  Mostrar todas las descargas., %

Figura 7. Descarga del bundle para otros sistemas operativos.
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El paquete descargado es un fichero comprimido que ocupa unos 400 Mbytes.

T T e
O@v| 4. <« suni ¢ Descargas » v|¢f|

Organizar - = Abrir Incluir en biblioteca »  » = = O .@.

Mombre . Fecha de modifica..  Tipg

e —— Je) [
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4. Descargas . adt-bundle-windows-x86 12/02/201310:14 Carg
v Dropbox g adt-bundle-windows-x86 12/02/201310:12 Arch
B Escritorio

(=] Sitios recientes

m

- Bibliotecas
3 Documentos
=l Imagenes
o Misica
B videos |

1M Equipo
£, sistema (C)

- 4| 1 | 3

adt-bundle-windows-x86 Fecha de modifica... 12/02/2013 10:14
{ Carpeta de archivos

Figura 8. Bundle descargado y descomprimido.

Descomprimid este paquete en un directorio dentro de vuestro equipo y renombrad la
carpeta, por ejemplo, con el nombre “android”.

C:\android

Dentro de esta carpeta deben estar a su vez 2 carpetas, una con el SDK y otra con
ECLIPSE, tal como se muestra en la figura 9.

No separéis estas dos carpetas, ni movais sus archivos a otro lugar, pues podria dar
lugar a problemas con el ADT desde el entorno Eclipse y habria que modificar las
preferencias.
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[ .. - - ' - - B
Setting Up the ADT Bundle = | |
&« C' | [1 developer.android.com/sdk/installing/bundle.htm! 7 @ A
Frany AT ouaCs TCrorcioe TouTs CUogIc sovIoTy p
Developer Tools Setting Up the ADT Bundle
Download ~ B
7 The ADT Bundle provides everything you need to start developing apps. including a version of the Eclipse IDE with built-in
Se“('ﬂ@ Up the ADT ADT (Android Developer Tools) to streamline your Android app development. If you haven't already, go download the
B Android ADT Bundle. (If you downloaded the SDK Tools only, for use with an existing IDE, you should instead read Setting
Setting Up an v Up an Bxisting IDE))
Existing IDE
i q
Exploring the SDK Install the SDK and Eclipse IDE
load th 1. Unpackthe ZIP file (named adt-bundle-<os_platform>.zip) and save it to an appropriate location, such asa
TomERi b "Development” directory in your home directory.
| Workflow v 2. Openthe adt-bundle-<os platform>/eclipse/ directory and launch eclipse.
Tools Help " That's it! The IDE is already loaded with the Android Developer Tools plugin and the SDK is ready to go. To start =
| developing, read Building Your First App.
Revisions v . . . . .
Caution: Do not move any of the files or directories from the adt-bundle-<os_platform> directory. If you move the
Extras o eclipse of sdk directory, ADT will not be able to locate the SDK and you'll need to manually update the ADT
| preferences.
Samples . . .
! ¥ Additional information
ADK v Asyou continue developing apps. you may need to install additional versions of Android for the emulator and other
packages such as the library for Google Play In-app Billing. To install more packages, use the SDK Manager.
Everything you need to develop Android apps is on this web site, including design guidelines, developer training, API
reference, and information about how you can distribute your app. For additional resources about developing and i
distributing your app, see the Developer Support Resources.
g+ ) as2
g ;:i:ir;d;;-’\‘:;;or:::?p v ¥ Mostrar todas las descargas... %

Figura 10. Opciones de configuracion del bundle.
Tened en cuenta el aviso descrito en CAUTION.

10



CURSO DE PROGRAMACION DE ANDROID TUTORIAL 1: INSTALACION DEL SOFTWARE

A continuacién debemos lanzar el programa SDK Manager que gestiona la instalacién
de las herramientas Android en nuestro equipo.

Desde el SDK Manager debemos seleccionar qué plataformas de desarrollo de Android
gueremos instalar en nuestro equipo. Esta operacion implica la descarga de multiples
ficheros desde internet, por lo que segun la conexidn que usemos, puede ser un
proceso mas o menos tedioso.

Instalad “Tools” y todas las versiones de las APIS.

Este proceso puede durar unos 30 minutos o un par de horas, en funcion de la
velocidad de tu conexidn a internet.

=
Android SDK Manager =R

Packages Tools
SDK Path:  C:h\Users\suni\Downloads\adt-bundle-windows-:86\android\sdk
Packages

Mame API Rev.  Status

a4 ] Tools

[ X% Android SDK Tools 21.01 &P Installed

[7] 74 Android SDK Platferm-tooels 1601 9 Installed
4 [T][£] Android 4.2 (AP11T)

| SDK Platform 17 1 9 Installed

[7] % ARM EABIvTa System Image 17 1 = Installed
a [|[ ] Extras

[ @8 Android Support Library 11 &9 lInstalled

Show: [¥]Updates/New [V|Installed  [| Obsolete Select Mew or Updates Install packages...

Sort by: @ AP level () Repository Deselect All Delete packages...

Fetching https://dl-ssl.gocgle.com/android/repository/addons_list-2 xml

Figura 11. Android SDK Manager
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( Android SDK Manager

|| Packages Tools

SDK Path: ChAndroidisdk I

Packages

i Mame API Rev.  Status
- @] Tools|

=] Android 4.2.2 (API17)
|=] Android 4.1.2 (API1&)
|=] Android 4.0.3 (API15)
|=] Android 4.0 (APT14)
[£] Android 3.2 (APT113)
[Z] Android 3.1 (APT112)
[#] Android 3.0 (APT11)
|=] Android 2.3.3 (API10)
|=] Android 2.2 (API&)
|=] Android 2.1 (APIT)
|=] Android 1.6 (APT4)
[=] Android 1.5 (4PI3)
|| Extras

VOW W YW W WYY W W YW

1 m | 3

Show: Updates/Mew Installed Obsolete Select Mew or Updates [ Install 9 packages...

Sort by: @ API level (7 Repository Deselect All [ Delete 55 packages...

Done loading packages.

Figura 12. Instalacion de las todas las APIS de Android

12



CURSO DE PROGRAMACION DE ANDROID TUTORIAL 1: INSTALACION DEL SOFTWARE

PASO 3: CREACION DE MAQUINAS VIRTUALES ANDROID

El tercer paso consiste en la creacién una maquina virtual que utilizaremos para
simular nuestras aplicaciones.

Para ello, desde el programa SDK Manager, debemos abrir el programa AVD Manager
(Android Virtual Device Manager) y crear una nueva maquina virtual.

Android SDK Manager =NACN X
Packages M
SDK Path: Manage AVDs... indows-xB6\android\sdk
Packages Manage Add-on Sites...
Mar, Options... API Rev.  Status G
About... 5
21.01 S Installed
¥ Android SDK Platform-tools 16.01 3 Installed
Android 4.2 (API17)
.| Documentation for Android SOK 17 1 -« Not installed
SDK Platform 17 1 S9installed
& Samples for SDK 17 1 & Mot installed
# ARM EABIvTa System Image 17 1 S9installed
® Intel x86 Atom System Image 17 1 & Not installed
7] i MIDS Suctem lmnne i7 T s Ant inctalled S
Show: [¥]Updates/New [V|Installed  [7] Obsolete Select [New or Updates Install 11 packages...

Sort by: @ (71 Repository Deselect All Delete 4 packages...
: . . . - . . =
Downloading Decumnentation for Android SDK, API17, revision 1 (6%, 258 KiB/s, 10 minutes |eft)

(8 - .

Figura 13. Abrir Manage AVDs desde SDK Manager.
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r ~

Andreid Virtual Device Manager o s e S

¢ Android Virtual Devices }| Device Definitions

List of existing Android Virtual Devices located at C:\Users\sunit.android\avd

AVD Mame Target Marne Platform API Level CPU/ABI New...

-- Mo AVD available -- --

Edit...
Delete...

Repair...

Details...

Start...

Refresh

~ Avalid Android Virtual Device. A repairable Android Virtual Device.
X An Andreid Virtual Device that failed to load. Click 'Details' to see the error.

Figura 14. Android AVD Manager

Pulsais sobre el boton de New y credis la nueva maquina.

Debéis ponerle un nombre, por ejemplo, la podemos denominar “mi_maquina” y en
Device, seleccionais Nexus One. De esta forma, se configurara una maquina virtual con
las caracteristicas del dispositivo movil “Nexus One”. Hay otras maquinas
predeterminadas y también podéis configurar una maquina virtual a medida. Pero para
el desarrollo de este curso, se recomienda utilizar sélo el modelo Nexus One.

En el apartado Target debéis seleccionar, por ejemplo, la APl 2.3.3. Pero, también
podéis generar varias maquinas Nexus One, pero para APIS diferentes (por ejemplo, la
2.1. 02.2)

14
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[ Create new Android Virtual Device (AVD) ﬁ1
AVD Name: mi_maguina
Device: |Nexus One (3.7, 480 x 720: hdpi) -
Target: | Android 2.33 - API Level 10 -
CPU/ABL ARM (armeabi) -
Keyboard: Hardware keyboard present

Skin:

Front Camera:

Back Camera:

Memory Options:

Internal Storage:

SD Card:

Emulation Options:

Override the existing AVD with the same name

Display a skin with hardware controls

Mone -
[None -
RAM: 512 VM Heap: 32

@) Size:

@) File: Browse...

[] Snapshot []Use Host GPU

0K J [ Cancel

Figura 15. Creacion de la maquina virtual
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F |
F% Android Virtual Device Manager @M
Android Virtual Devices | Device Definitions
List of existing Android Virtual Devices located at C:\Users\suni\.android\avd
AVD Name Target Name Platform API Level CPU/ABI New.
v mi_maqguina Android 2.3.3 233 10 ARM (armea... Edit
Delete...
Repair...
Details...
Start..
Refresh
i[| *~ Awvalid Android Virtual Device. = A repairable Android Virtual Device,
% An Android Virtual Device that failed to load. Click 'Details’ to see the error.

Figura 16. Maquina virtual creada.

-
@ 5554:mi_maquina _

See all your apps.
Touch the Launcher icon.

d to provide input

Figura 17. Aspecto de la maquina virtual (Nexus One)

16
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Ahora en el siguiente paso, realizaremos nuestro primer proyecto, el HolaMundo.

PASO 4: EJEMPLO HOLA MUNDO

Pasos a realizar:

1) Abrid el entorno de desarrollo Eclipse (eclipse.exe)

Al abrir Eclipse por primera vez, éste os pedira que le indiquéis la ubicacién de
vuestra carpeta workspace (que es donde se guardaran todos los proyectos).
Seleccionad la ubicacion que querais, por ejemplo en el directorio raiz como se
muestra en la figura 18.

-

= Workspace Launcher I Iﬁ

Select a workspace

Eclipse stores your projects in a folder called a workspace.
Choose a workspace folder to use for this session.

Workspace: - Browse...

[] Use this as the default and do not ask again

| ok || cancel |

Figura 18. Ubicacién del workspace
A continuacion, aparecerd una portada de bienvenida que explica

resumidamente cémo generar un nuevo proyecto Android. Debéis cerrar esta
pantalla de bienvenida y entonces veréis el entorno completo de Eclipse.
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File Edit Run Mavigate Search Project Refactor Window Help

[ {}) Java - ADT

(&) Android IDE i2

Welcome!

The Android Developer Tools provide a first-class development environment for building Android apps. This integrated
development environment is set up with the latest version of the Android platform and system image so you can
immediately begin building apps and running them on the Android emulator.

To start a new Android app project:

1. Click File > New > Android Application Project.
(If you don't see this option, click File > New > Other, then open the Andreid folder and select Android Application

Project.)

2. Follow the wizard to set up your new Android app project.

For a complete walkthrough that shows how to create a new project and build a simple app, read Building Your First App.

To set up a real Android device for testing your app, read Using Hardware Devices. If you don't have a device and need to
use the emulator, read Managing Virtual Devices.

Although your Android SDK already includes the latest version of the platform and system image, you may later want 1o
install other Android versions or packages such as the Android Support Library. For help installing additional packages,

read Adding Platforms and Packages.

Build Your First App »

IT you're new to Android, follow
this class to learn the fundamental
Android APIs for creating a user
interface that responds to input.

Design Your App »

Before you begin developing your
app, be sure you understand the
design patterns that Android users
expect from your app.

Test Your App »

The Android framework provides
tools that help you test every
aspect of your app to be sure it
behaves as it should under

various conditions

m,

g 26M df S1M @

Figura 19. Pantalla de bienvenida

r@ About ADT

Android Developer Teols

Build: v21.0.1-543035

This product includes Eclipse Platform, JDT, CDT, EMF, GEF and WTP,
all of which are Copyright (c) Eclipse contributors and others.

Visit http://eclipse.org/

Android Developer Teols are Copyright (¢) The Android Open Source Project.
Visit http://develeper.android.com fl

&0

@ Installation Details

Figura 20. Version de eclipse instalada.
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2) Desde el menu superior, seleccionad File>>New>>Android Application Project.

3) Denominad al proyecto “HolaMundo”, seleccionad la plataforma Android

2.3.3. (Gingerbread), y el nombre del paquete “com.lcsi.holamundo”.

-

= New Android Application | B -
New Android Application @
Creates a new Android Application

Application Name:® HolaMundo

Project Name:® HolaMundo

Package Name:® com.lcsi.holamundo ‘
Minimum Required SDK:B[API 10: Android 2.3.3 (Gingerbread) vl
Target SDK:9|APL 17; Android 4.2 |
Compile With:o| AP1 17: Android 4.2 v|
Theme:ﬁlHDID Light with Dark Action Bar VI

=}

Choose the highest API level that the application is known to work with. This attribute informs
the system that you have tested against the target version and the system should not enable any
compatibility behaviors to maintain your app's forward-compatibility with the target version.
The application is still able to run on older versions (down to minSdkVersion). Your application

Figura 21. Nombre del proyecto.
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4) A continuacién puedes elegir el icono de tu aplicacion mediante el siguiente

menu:
F
2 New Android App i=h
Configure Launcher Icon e
Configure the attributes of the icon set
_ Preview:
Foreground: | Image || Cli Text
ground: Image |Glipart Text =
F
# &
mdpi:
F- Y
Trim Surrounding Blank Space L
Additional Padding: hdpi:
[ini] 10% | LN

4
Faoreground Scaling: l '

Shape | None SquarelCircIeI xhdpt:
B
Background Color:E l '

Foreground Colo

@ <Back | Next> | Emsn || cancel

Figura 22. Icono de la app.

Elige un clipart por defecto o alguna imagen que tengas en tu ordenador.
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5) En lasiguiente pantalla, elige Blank Activity

= New Android Application

Create Activity e
Select whether to create an activity, and if so, what kind of activity.

I Create Activity

BlankActivity !
FullscreenActivity

LoginActivity
MasterDetailFlow
SettingsActivity

New Blank Activity

Creates a new blank activity, with optional inner navigation.

@ TR e [

b

Figura 23. Seleccion del tipo de actividad
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6) A continuacion, aparece el menu donde nombramos a nuestra actividad
principal y el layout. Deja los valores que aparecen por defecto.

<= New Android Application u@lﬁ

New Blank Activity @
Creates a new blank activity, with optional inner navigation.

Activity Name® MainActivity
Layout Name® activity_main |

Mavigation TypeﬁlNone vl

@ The name of the activity class to create

@j Mext = Einish ] l Cancel

Figura 24. Nombres de la actividad principal y el fichero de layout.

7) Pulsa sobre finalizar, y el proyecto se genera automaticamente.
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8) Ejecuta esta aplicacion mediante Run As>>Android Application y en unos
segundos aparecera el simulador con tu aplicacion de “HolaMundo”

@ 5554:mi_maquina

HelloWorld

Hardware Buttons

ard to provide input

Hello world!

Figura 25. Hola Mundo
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9) Y ahora prueba a ejecutar la aplicacion HolaMundo en tu Smartphone o
Tableta.

Para ello, debes tener instalados los drivers de tu dispositivo en tu equipo de
trabajo.

Puede que ya los tengas instalados si anteriormente has conectado el
dispositivo al equipo mediante su cable de conexion USB con el objetivo de
copiar fotografias u otros documentos.

También debes realizar estos cambios en la configuracidon de tu dispositivo
movil:

9.1) Activa la opcion de Desarrollador. En Ajustes, Opciones de
desarrollador, debes activar la opcidon de Depuracion USB.

Y 7 TR TEFTEE
@ Ajustes < @ Opciones de desa. I

Contraseia de la copia de segu.
® WhatsApp La *‘ Iric itorio

@ Anadir cuenta

Sistema

B Movimiento

B Accesorio -
Depuracion

@ Fechay hora Depuracion de USB
W Accesibilidad Permitir ubicaciones falsas
Opciones de desarrollador Seleccione una aplicacion p.

1dC ng 1ad dplical ) >

@ Acerca del dispositivo

Figura 26. Activar opcidn de Desarrollo
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9.2) Permite que se instalen aplicaciones externas a Google Play. Para ello,
en Ajustes ve a Seguridad y activa Fuentes desconocidas.

@ Ajustes < @ Seguridad

Personal
Contrasenas

@ Servicios de ubicacion . .
Hacer las contrasefas visi. v/

@ Pantalla de bloqueo Administracion de dispositivo
Administradores de dispositivos
- Seguridad Ver « tivar administradores de

B Idioma e introduccion VFuen‘tes desconoqldas

® Copia de seguridad y restab.

Almacenamiento de credenciales
Cuentas

A

Credenciales de confianza
Correo electrdnico Mastearcart ALCE cantianza

Instal desde almac dispositivo
$ Dropbox Nisla A eRricAQo cend

f Facebook

Figura 27. Permitir la instalacion de aplicaciones de
origenes distintos a Play Store

10) Conecta el cable de conexiéon USB al dispositivo Android y a tu equipo de
trabajoy envia el programa HolaMundo.
Si los drivers estan instalados correctamente, desde Eclipse, en la ventana
Android Device Chooser debe aparecer tu dispositivo junto con la maquina
virtual que se configuré anteriormente.
Debes seleccionar tu dispositivo, en el caso de la figura 26, se trata de un
Smartphone Galaxy S3 (Samsung-gt_i9300-........... )
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-

< Android Device Chooser

)

Select a device with min API level 8.

@iChoose a running Android device:

Serial Number AVD Name Target Debug State
Emi_maquina [emulator-5554] mi_maguina + Android 2.3.3 Yes Online
=] samsung-gt_i9300-4df17e0751.. N/A 412 Online
() Launch a new Android Virtual Device
AVD Name Target Name Platform AP Level CPU/ABI Details...
= No AVD available = = -
Start
Refresh
Manage
["]Use same device for future launches OK l l Cancel

)
"iHola mundo!

Figura 29. Aspecto del ejemplo HolaMundo en el Smartphone Samsung Galaxy S3.
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